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 Welcome!… 
  

Welcome to eBLVD Online Meetings®. 

  

 eBLVD Online Meetings® instantly turns your web browser into a complete personal communication tool, 
enabling you to have real-time meetings whenever you want. 

  

The service provides you the ability to share your screen, have a phone conference, and pass out 
handouts or documents from your desktop for efficient and productive meetings. You can easily invite 
attendees to your demos, training, or collaboration sessions, instantly broadcast any application on your 
PC to their web browsers, and even allow them to control your keyboard and mouse.  

  

In just a few minutes, you'll be equipped to start presenting content to customers and associates anytime, 
anywhere.  

  

Let's get started. 

  

  
Note: Information in this document is subject to change without notice. The software described in this document is 
furnished under a license agreement or nondisclosure agreement. The software and documentation may be used or 
copied only in accordance with the terms of those agreements. No part of this publication may be reproduced, stored in a 
retrieval system, or transmitted in any form or any means electronic or mechanical, including photocopying and recording 
for any purpose other than the purchaser's personal use without the written permission of ENC Technology Corp. 
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Let's get started 
  

eBLVD Online Meetings provides you with a personal online meeting space in which up to 30 people can 
collaborate via the web in real time. In your meeting space, you and other participants can share your 
computer screen, use text chat and teleconferencing, record live video, and exchange handouts and other 
files.  

  

The Basics: 

When you create an eBLVD account, you are provided with a single co-branded URL for you and your 
participants to go for all your meetings. You will share your meeting URL with others so that they can 
attend meetings in your meeting space. For example, you can send the URL in an e-mail invitation or 
instant message, or simply tell them the URL over the phone.  

  

Participants join a meeting by clicking on the meeting URL link or by typing the URL into the address field 
of a web browser. The audio portion of the meeting is conducted by either a toll or toll-free number, which 
will also be provided. Participants cannot enter the meeting space unless the host is present and has 
started the meeting.  

  

As a participant, your capabilities in a meeting depend on your permissions, which are assigned by the 
host. All attendees can view a shared computer screen, use the teleconferencing service, receive meeting 
handouts, and text-chat with the host and other attendees.  

  

You can start your first online meeting in three basic steps: 

1. Create an account. To start a meeting, you need your own eBLVD account. You can create an account 
by visiting eBLVD.com or by clicking the link that somebody in your organization may have provided you.  

2. Set up your host. Prior to your first meeting you will need to download the Meeting Manager Applet 
onto your PC. This applet will provide the functionality that you need to manage your participants. The link 
to download the applet will be provided the first time you use the system. 

3. Invite participants. Once you've set up your host applet, you can invite someone to a meeting on the 
spot, or at a specific time, by simply providing your meeting URL. If you want to use advanced features 
such as recurring meetings, toll-free conferencing, or meeting handouts, you can use your web account 
to do so. 

  

Phone Conferencing: 

To make it easy for participants to listen to the meeting via telephone, the Presenter can 
display conference call information to Participants in advance, or as they join the meeting. An 
eBLVD phone conference number and access code is provided with every meeting (Regular 
long-distance rates apply).  
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Product features 
• Unlimited use for up to 30 participants:  Easy-to-use screen sharing, chat, and audio 

conferencing. Personalized, easy-to-remember URL for instant meeting access. 

• Intuitive User Interface: Easy-to-learn web interface enable you and your participants to start 
meeting online in seconds without training. Your sales staff will spend more time presenting to 
customers and less time working through technical obstacles. 

• Always-on meetings: Your eBLVD meeting space is easy to access at any time through your 
personal, co-branded meeting URL. Invite people by sending your Meeting URL, such as 
http://meeting.eBLVD.com/[PresenterID]. 

• Full desktop sharing: Share your screen to present, discuss and review documents in 
real-time 

• Participant management: Hosts can view who is in the meeting space in addition to each 
participant's permissions (keyboard/mouse control, file transfer, voice chat, recording) and status 
(whether the participant is connected). 

• Start Meeting feature: Use the convenient Start Meeting feature to start an ad hoc meeting and 
invite participants from your desktop, web browser or email application. 

• Transparent Meeting Manager Panels: Allows presenters to keep their Meeting Manager panels 
open on their screen while screen sharing and chatting. 

• Remote Access and Control: Any participant that is granted the privilege can securely take over 
the presentation in real time.  

• True 24-Bit Color: Share presentations, graphics, pictures and PC applications with all customers 
in true 24-bit color. 

• Desktop Session Recording and Playback: Allows Meeting Participants to record and play back 
meetings for training or later reviews.  

• Chat Window: Chat online with your participants during a meeting. 

• File Transfer: Transfer any type of file to and from a Participan's computer. 

• Integration: Easily initiate eBLVD Meetings through various email and web-based applications.  

• Reporting and Activity Logs: Get detailed reports on participant activity for trend analysis and 
ROI validation. 

• Flexible Licensing: Purchase only the licenses you need today and add additional licenses as you 
need them.  
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Security 
eBLVD Online Meetings® addresses your security concerns: 

• There is no need to open any extra ports on your corporate or personal firewall, as all 
communication between the Meeting Presenter and the Participant’s PC make use of standard 
web protocols (HTTP and HTTPS). 

• An encrypted end-to-end connection is established between Meeting Presenter and participant(s), 
using established Internet protocols (128-bit SSL). 

• Presenters and Participants (optionally) are authenticated using strong passwords and unique 
Meeting IDs. 

• Meetings are initiated by the host: a Meeting Participant cannot examine a host/presenter’s PC 
without being re-invited to do so by the host/presenter. 

• Once the meeting session has ended, all access rights to access the host’s PC are removed. 

• The Meeting Presenter management model makes it possible to limit specific functions to certain 
Meeting Participants. For example, the Presenter can determine which Participants can record or 
pass files during a meeting. 

• Session connection data is recorded to provide an audit trail of all Meeting Participant’s connection 
information.  
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System requirements 
There are some minimum system requirements for the Meeting Presenter and the Participant PCs, which 
are as follows: 

  

Meeting Presenter PC  

•  Microsoft Windows 95, 98, ME, 2000, XP, Server 2003, or Vista.  

•  A working Internet connection (minimum recommended speed 56Kbits/sec.)  

•  Internet Explorer 5.5 or later, with support for 128-bit encryption. Mozilla-based browsers that 
are compatible include Firefox 1.5 or later, and Mozilla 1.7 or later.  

• For Outlook Integration: Microsoft® Outlook® 2000 or later 

• For Lotus Notes® Integration: IBM® Lotus Notes® Version 6.5 or later 

  

Participant (remote) PC 

•  Microsoft Windows 95, 98, ME, 2000, XP, Server 2003, or Vista.  

•  A working Internet connection (minimum recommended speed 56Kbits/sec).  

•  A web browser that supports 128-bit encryption. Note: The speed of file transfers, among other 
things, is determined greatly by the speed of the Internet connection, we recommend a minimum 
upload capacity of 128Mb/s.  

• A PC video player such as Media Player, Real Player, or equivalent (if session recording is enabled). 

• For Outlook Integration: Microsoft® Outlook® 2000 or later 

• For Lotus Notes® Integration: IBM® Lotus Notes® Version 6.5 or later 
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Terminology 
Throughout this guide we will use various terms. Some definitions are listed here in alphabetical order: 

• Account Administrator - A user who has the authority to create, maintain and monitor one or 
more Meeting Presenters. 

• Account Password – An account password is what presenters use to log in to the eBLVD Meeting 
Center.  

• Co-branding - An eBLVD account can be co-branded to display the Presenter's company or 
personal logo and colors. When this has been set up, your participants will see your logo and 
colors, instead of the eBLVD brand when they access eBLVD. 

• Customer - A person who views the Presenter's meeting. See Participant.  

• Host - A person who conducts a presentation. See Presenter. 

• Meeting ID – A meeting ID is assigned by eBLVD and is used to help authenticate participants. 
Requiring and specifying a meeting ID provides enhanced privacy guarantees for the meeting by 
ensuring that only participants that know the meeting ID may join the meeting. If this enhanced 
privacy is non needed, presenters can mark the meeting "Public". 

• Meeting Participant - A person who attends a meeting and views the shared screen of a Meeting 
Presenter. A participant can also use the Text Chat Panel. A participant may also contribute 
meeting content, record the meeting, or control the keyboard and mouse if the host grants them 
the corresponding permission. 

• Meeting Presenter - A person who invites and presents to Participants via the Web. Presenters 
can grant or deny access to the meeting, show their desktop, or pause showing their desktop at 
any time. Presenters may grant Participants the ability to share control of their mouse and 
keyboard, share files, or record live video. 

• Meeting Manager Applet - The eBLVD host application that makes setting a Participant's 
permissions while in a meeting possible.  

• Meeting Viewer – The Viewer is the window displayed on the participant's PC in which the 
presenter’s desktop or shared application appears. The Viewer Window has its toolbar. 

• Online Meetings Center  - A customized, co-branded web site on eBLVD that is used by 
presenters to manage their accounts and host meetings and by participants to join meetings.  

• Permissions - What the Meeting Participant is allowed to do on the Presenter’s PC. The Presenter 
can always prohibit a Meeting Participant’s action. 

• Preferences Page - The place within eBLVD Online Meetings® from where Administrators can 
customize the function of their Online Meetings system. From here they can define other Meeting 
Presenters; setup or configure co-branding; and make Meeting Preference changes. 

• Presenter’s Desktop Image – The presenter’s desktop image is the picture of the presenter’s PC 
desktop that appears to participants in the Viewer Window. 

• Remote Control- The Meeting Participant taking over control of the Presenter’s PC.  

• Remote Viewing - The Meeting Participant viewing the screen of the Presenter’s PC. The Meeting 
Participant can only view the screen, and cannot control the mouse and keyboard unless those 
permissions are granted to a given Participant.  

• Report - An overview of one of many areas of performance over a specified time period. 

• System tray icon - The eBLVD system tray icon is used to access features of eBLVD and to 
provide status of the eBLVD service. 
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Online Meetings Center 
The Online Meetings Center page is the place on the web that you go to download the Meeting Manager 
Applet or Outlook Add-In, view your pending and previous meetings, create scheduled and ad-hoc 
meetings, cancel or change a meeting, configure your Meeting Preferences, and otherwise manage 
your eBLVD account. 

  

To access your Online Meetings Center page, simply open your web browser and type 
"http://www.eBLVD.com" in the address bar. Next, enter your eBLVD Username and Password. 

  

Your Online Meetings Center page will appear in a format such as this: 
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Meeting preferences 
Meeting preferences are Administrator settings that control the visual and functional aspects of the 
service. The Meeting preference options are: 

• Configure co-brand settings: This is where you configure settings to make all Participant and 
Presenter pages on eBLVD look like your own web site. 

• Default start page: Here, you set the default page you will be taken to after logging in to your 
account. 

 Note: This step is optional, and only needs to be done initially, and any time your needs change. 
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Installing the Meeting Manager applet 
The Meeting Manager applet provides the functionality that you need to manage your participants. The 
link to download the applet will be provided the first time you sign in to the system. 

  

You can also direct your web browser to the following URL to download the Meeting Manager applet: 
https://www.eBLVD.com/setup. 

  

 Note: This step is required, and only needs to be done initially, and any time you get a new PC.  
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Ad-hoc meetings 
Ad-hoc meetings are any meetings that a Presenter starts without first scheduling them in advance. This 
is an ideal feature for last-minute and on-the-fly meetings that need to occur without prior notice. 
Presenters can schedule Ad-hoc meetings from the eBLVD web site, the Windows Start Menu, MS-Outlook 
or Lotus Notes, or the eBLVD system tray icon. 

  

Using the eBLVD web site: Open your web browser and type "http://www.eBLVD.com" in the Address 
Bar. 

  

Using the Windows Start Menu: From your Windows desktop, click the Start button, select "All 
Programs" menu. From the menu, click eBLVD, then "Login to eBLVD". 

  

Using MS-Outlook or Lotus Notes: From your email application, click the eBLVD button, then "Login to 
eBLVD". 

 
  

On the Login page , enter your Username and Password. This should take you to your Online Meetings 

Center page. Here, you will click the  icon to enter four pieces of info to start an ad-hoc 
meeting. 

  

 On the Meet Now page, enter: 

• Meeting Name – this is the name of the ad-hoc meeting.  

• Duration - Enter the number of minutes of your meeting. Once the Duration from the current 
moment in time has elapsed, your meeting ID is no longer valid for Participants. 

• Optional Access Code - You can add an optional Access Code that restricts acceptance into the 
meeting unless this code is matched to the Meeting ID. 

• Conference call information – this is the information attendees will use to conference into the 
meeting, you can choose to use the assigned conference call number; assigned toll-free conference 
number (fees will apply); or provide your own.  

• Additional Details - these details will be pre-filled from your account information and normally 
wouldn't be overridden. 

 Note: To start an Ad-hoc meeting the eBLVD Meeting Manager Applet must be installed on the PC 
being used by the Presenter. For more information on installing the Meeting Manager Applet click here.  
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Scheduling a pre-planned meeting 
Presenters can schedule pre-planned meetings from the eBLVD web site, the Windows Start Menu, MS-
Outlook or Lotus Notes, or the eBLVD system tray icon. 

  

Using the eBLVD web site: Open your web browser and type "http://www.eBLVD.com" in the Address 
Bar. 

  

Using the Windows Start Menu: From your Windows desktop, click the Start button, select "All 
Programs" menu. From the menu, click eBLVD, then "Login to eBLVD". 

  

Using MS-Outlook or Lotus Notes: From your email application, click the "eBLVD Login" button, then 
sign in to eBLVD. 

 
  

Using the system tray icon: Right-click the  eBLVD system tray icon and select Schedule Meeting. 

On the Login page , enter your Username and Password.  This should take you to your Online Meetings 

Center page. Here, you will click the  icon to enter your meeting details.  

On the Schedule New Meeting page, enter: 

• Meeting Name – this is the name of the meeting.  

• Start Date and Time - Meeting start and end times.  

• Duration - Enter the number of minutes of your meeting. Once the Start Time and Duration have 
elapsed, your meeting ID is no longer valid for Participants. 

• Time Zone - Select your Time Zone to ensure Participants across time zones arrive at the proper 
time. 

• Occurrence - Choose either "One Time" or "Recurring". Recurring Meetings are automatically 
scheduled out for you based on your selected frequency and reduces repetitive typing. 

• Privacy - Choose Private or Public. Public meetings are displayed on your Meetings Portal page. 
Private meetings are not. 

• Optional Access Code - You can add an optional Access Code that restricts acceptance into the 
meeting unless this code is matched to the Meeting ID. 

• Conference call information – this is the information attendees will use to conference into the 
meeting, you can choose to use the assigned conference call number; assigned toll-free conference 
number (fees will apply); or provide your own.  

• Additional Details - here you can enter another Presenter's host and contact info, add a Meeting 
Type or Agenda. 

  

 Note: If you are using Microsoft Outlook or IBM Lotus Notes, a meeting reminder will be generated. 
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Overview of hosting a meeting 
Your eBLVD account provides you with a personal meeting space that you can sign in to any time you 
want to collaborate with someone online.  

The eBLVD meeting space contains the main display area, of which any application (PowerPoint, Web app, 
etc.) is broadcast to your Participants, and the Meeting Manager - controls that are available and seen 
only by the Presenter.  

The meeting space becomes available to others only if you (the Presenter, or host) are sitting at your PC, 
provide the meeting URL and ID to a Participant, and either click "Share Desktop" or accept late-comer's 
requests to enter.  

Late-comers (those that request to attend after the meeting has started) are queued in the "Waiting 
Room", and you can choose to accept them in when convenient, or not. To allow later-comers in, simply 
click the "Waiting" button, then "grant" them permission to attend. 

 
eBLVD also comes with an integrated conference call service at no extra cost to you. The Presenter and 
all participants dial a toll-based number that is assigned when each meeting is created. Participants are 
then charged their standard long-distance rate for calling this toll-based number, just as if they made a 
regular long-distance call. You may decide to use this service, upgrade to our toll-free service, or choose 
another method of bringing audio to your online meetings. 
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Overview of hosting a meeting 
Your eBLVD account provides you with a personal meeting space that you can sign in to any time you 
want to collaborate with someone online.  

The eBLVD meeting space contains the main display area, of which any application (PowerPoint, Web app, 
etc.) is broadcast to your Participants, and the Meeting Manager - controls that are available and seen 
only by the Presenter.  

The meeting space becomes available to others only if you (the Presenter, or host) are sitting at your PC, 
provide the meeting URL and ID to a Participant, and either click "Share Desktop" or accept late-comer's 
requests to enter.  

Late-comers (those that request to attend after the meeting has started) are queued in the "Waiting 
Room", and you can choose to accept them in when convenient, or not. To allow later-comers in, simply 
click the "Waiting" button, then "grant" them permission to attend. 

 
eBLVD also comes with an integrated conference call service at no extra cost to you. The Presenter and 
all participants dial a toll-based number that is assigned when each meeting is created. Participants are 
then charged their standard long-distance rate for calling this toll-based number, just as if they made a 
regular long-distance call. You may decide to use this service, upgrade to our toll-free service, or choose 
another method of bringing audio to your online meetings. 
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the Share Panel 
The Share Panel displays content from the Presenter’s computer (including windows, applications, or the 
entire desktop) to the Participant's web browser. 

  

As a host or presenter, you can use the Share Panel to share an open application or applications, or your 
entire desktop. A visual representation of your screen appears in your participants' Meeting Viewer, and 
participants can watch your screen update as you use your keyboard and mouse. You can also pause or 
stop the broadcast, using the Presentation Controls. 

  

While stopped or inactive, the host’s Share Panel displays the customizable Welcome Screen. While 
paused, the Share Panel displays a snapshot of the last screen broadcast. 
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the Participant List Panel 
The Participant List Panel displays the name and permissions of each attendee. This panel allows the host 
to change a participant’s permissions and monitor connection status. 

  

From the Participant List Panel, you can quickly see who is logged in to a meeting. You can view 
everyone’s name and one or more icons that denote permission status. The host is listed first, followed by 
participants.  
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the Sharing Controls Panel 
The Sharing Controls Panel allows the Presenter to broadcast, pause, or stop the broadcast of live video to 
all Participants. 

 
The default setting of the Presentation Controls is STOP. While stopped or inactive, the host’s Share Panel 
displays the customizable "Welcome, Please Wait" screen.  

  

To begin the live broadcast of your screen, simply click the PLAY button. You will notice that the text 
changes to "Shared" and the button immediately changes from PLAY to PAUSE. 

  

To Pause your meeting, click the PAUSE button. While paused, the Share Panel displays a snapshot of the 
last screen broadcast. The PAUSE button changes to a PLAY button. 

  

To Stop your meeting, click the STOP button. The host’s Share Panel will then display the "Welcome, 
Please Wait" screen. 

  

Note: Stopping your meeting will not disconnect your participants. While they can no longer view your 
screen, it is a good idea to indicate at the end of your meeting that the meeting is now over and 
participants should close out their Meeting Viewers. You can force a disconnection of all participants from 
your Participant List Panel, simply right-click on any participant and select "Disconnect All". 
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the Chat Panel 
The Chat Panel allows the Presenter to send chat messages to Participants, and to view messages sent by 
Participants directed to the host or Everyone. 

  

When you receive a text message, your Chat Panel shows the sender’s name and the message. 

  

While you are in a meeting, all the messages you send and receive remain in your Chat Panel. When the 
Presenter ends a meeting, the Chat Panel text can be cleared or saved.  

  

To clear the chat text, select "Clear History" from the Edit Menu of Meeting Manager. 

  

To preserve the chat history, select "Save History" from the File > Text Chat Menu of Meeting Manager.  
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the Voice Panel 
The Voice Panel allows the Presenter to send audio from his PC microphone to other attendees using 
VOIP.  

The Presenter may choose to enable Voice Chat Microphone and Voice Chat Speakers for Participants 
during a meeting. This can be done by right-clicking on the participant's name and selecting "Enable Voice 
Chat Microphone" or "Enable Voice Chat Speakers".  

  

The Microphone icon will be displayed next to the participant "holding" the microphone. The Speaker icon 
will be displayed next to each participant with "Voice Chat Speakers" enabled. Only one Participant may 
"hold" the microphone at one time. 

  

To control the volume settings using the Voice Panel. Move the "Talk" volume indicator to adjust the 
microphone volume. To open the speaker volume settings, click the vertical bar to the right of the "Talk" 
volume bar. Move the "Listen" volume indicator to adjust the speaker volume.  
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Attending a meeting 
To enter a meeting as a participant, all you need is the host’s meeting URL and ID. The host may send 
this URL in an e-mail invitation or instant message, or you may have book-marked it from a previous 
meeting. The meeting URL takes the form of http://meetings.eBLVD.com/[PresenterID], where 
[PresenterID] is the login ID of the Presenter. 

  

From the login screen, you can enter the meeting as a guest by typing the name you want displayed to 
other meeting participants. The host receives your request to enter the meeting and can accept or decline 
it. 

  

 Note: If the host has not yet started the meeting, you are asked to wait. After the host has started the 
meeting , your browser displays the meeting space. 
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Viewing the Meeting Space 
Viewing the Presenter’s screen 

 To view the presenter’s screen, click the "Attend Meeting" button and enter your name when prompted.  

  

Controlling the Presenter’s PC 

To control the presenter’s PC, you must first be granted that "permission" from the Presenter. The 
Presenter selects your name from the Participant Panel, then clicks "Grant Control" button. You can now 
operate the Presenter's PC as if you were sitting in front of it.  

  

Transferring Files to/from the Presenter’s PC 

To transfer a file to/from the presenter’s PC, you must first be granted that "permission" from the 
Presenter. The Presenter right-clicks your name from the Participant Panel, then clicks "Allow 
File Transfers"menu option. You can now transfer files. 

  

Recording the Presentation 

To record a Presentation, you must first be granted that "permission" from the Presenter. The Presenter 
right-clicks your name from the Participant Panel, then clicks "Allow Recording" menu option. You can now 
transfer files. 
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the Participant toolbar 
Participants have some built-in tools, and Presenters may grant Participants additional options while 
connected to a meeting. Once you have connected to the Meeting Space, the eBLVD Meeting Viewer 
toolbar is displayed. 

Clipboard Transfer - You can copy text or graphics FROM the Presenter's PC, TO your PC (or vice-versa): 
To copy text or graphics FROM the Presenter's PC, to your PC:  

1. On the Presenter's PC, right-click on the text and/or graphics to be copied to the Participant, and 
select Copy (placing the text and/or graphics in the clipboard). 

2.  Click the far left icon on the Meeting Viewer toolbar (Copy text/graphics from host). 

3. You may now paste the copied text/graphics onto your PC.  

To copy text or graphics FROM your PC to the Presenter's PC:  

1. On your PC, right-click on the text and/or graphics to be copied to the customer, and select Copy 
(placing the text and/or graphics in the clipboard). 

2. Click the second icon from the left on the Meeting Viewer toolbar (Paste text/graphics to host).  

3. You may now paste the copied text/graphics onto your Presenter's PC. 

File Transfer - During a support session, you can transfer a file or files to or from your Presenter's 
computer. For example, you can deliver handouts to a Participant's PC, or the Participant can pass their 
own files into the Meeting.  

 Real-time Chat - You can send and receive chat messages to and from a customer. Chat is useful if you 
want to communicate with a customer without using a telephone. For example, if a customer's call to your 
technical Online Meetings is a long-distance call, you can use chat to help the customer avoid long-
distance charges. Either you or a customer can initiate a chat session.  

To send chat messages:  

1. On the Meeting Viewer toolbar, click the Chat icon.  

2. The Chat panel appears. In the Send to drop-down list, select the name of the person to whom you 
want to send a chat message. If you want to send a message to all participants in the session, 
select All. 

3.  Type a message in the box. 

4. Click Send. The recipient that you selected receives the chat message in his or her Chat panel. 

5. Any messages that a customer or another support representative sends appear in your Chat panel. 

Screen Scaling - You can 'scale' or 'size' the Meeting Applet screen once you have connected to your 
customer's PC. You can also have multiple Meeting Applet screens open at once to work on multiple issues 
simultaneously. To use Screen Scaling: 

1. Click the Scale button on the Meeting Viewer toolbar 

2. "Grab" any corner of the Applet screen and size to the desired height and width. 

3. To resume back to normal size (the exact size based on the host's screen resolution), un-depress 
the Scale button. 

Screen Recording-You can start recording a meeting once you have connected to the Meeting Space and 
have obtained permission from the Presenter. To start recording:  

1. Click the Record Session button on the Meeting Presenter Console Applet toolbar 

2. Name the file and designate the location for the recorded file to be saved 

3. Click the "Save" button 

4. When you are done recording, simply click the "Stop Recording" button on the Meeting Presenter 
Console Applet toolbar, or close the Meeting Presenter Console Applet.  

Screen Capture - You can capture meeting graphics once you have connected to the Meeting Space and 
have obtained permission from the Presenter. To start capturing:  

1. Click the Screen Capture button on the Meeting Presenter Console Applet toolbar 

2. Name the file and designate the location for the screen capture graphic file to be saved  
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Chat with other participants 
Participants have their own "Meeting Tools" that allow them to use the Chat Panel to send a message to 
the Presenter, just one Participant, or to all participants. Be sure to select the message recipient before 
sending the message. 

  

Your Meeting Tools Chat Panel may already be open by the Presenter. If not, click the  tool bar 
icon at the top of your screen. At the bottom of the Chat Panel, click the down-arrow button and select a 
recipient:  

• Select Everyone to send a message to all participants.  

• Select the presenter to send a message only to the presenter.  

• Select the name of an participant to send a private message to just one person.  

  

Click in the small box above the recipient and type your message. To send the message, do one of the 
following: Type your message, then click Send. The message appears in the top portion of each recipient’s 
Chat Panel. 
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Ending a meeting 
To end a meeting as a Presenter 

As a host, you can end a meeting by selecting File > Participants > "Disconnect All"; or by right-clicking 
on any Participant and selecting "Disconnect All".  

  

To preserve the chat history, the Presenter can save the contents of the Chat Box dialog to a text file on 
the Presenter's PC. 

  

To end a meeting as a Participant  

As a Participant, you can end a meeting by simply closing the Meeting Viewer window, or selecting the Exit 
button on the Viewer tool-bar. 
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Recording a meeting 
You can record a meeting once you have connected to your presenter's Meeting Space and have obtained 
permission from the Presenter.  

  

eBLVD creates one recording file per meeting. If you pause and restart a recording during the course of a 
meeting, each recorded segment will be appended to the recording file in progress for that meeting. 

  

To start recording:  

• Click the Record Session button on the Meeting Viewer toolbar. 

•  Name the file 

• Designate the location where you want to save your recording 

• Click the "Save" button. 

  

To stop recording: 

• When you are done recording, click the "Stop Recording" button on the toolbar 

• Close the Meeting Viewer. 

  

 Note: For optimum recording performance and in-session experience, it is recommended that you 
select a location on your local hard drive.  

 Note: You cannot change the Save location setting once you have started to record a meeting. If you 
do not specify a destination location, the default is My Documents.  

 Note: The lower you set your monitor resolution, the better the quality of the meeting recording. A 
resolution of 1024 x 768 is optimal for acceptable recording quality. 
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Playing a recorded meeting 
eBLVD meeting sessions are recording in AVI format. 

  

To replay a meeting recorded in the Windows AVI format: 

• If you haven’t already, end the meeting that you are recording 

• Make sure you have video playback software such as Windows Media Player, Real Player, or 
equivalent installed on your PC. 

• eBLVD will save your file with the name and location that you specified. 

•  Click the file name to start the replay.  

• Press Alt and Enter on your keyboard at the same time to maximize the Viewer Window for best 
replay quality.  
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FAQ and troubleshooting 
I've forgotten my password 

To retrieve or change the password for your online account, click here to obtain an email link to reset it. If 
you've forgotten the password for a Host PC, you will need to re-install the host software on that machine.  

  

I need help with Meeting Recording 

Meeting Recording is currently available from the Meeting Viewer on the Participant side. To enable 
Session Recording , the Meeting Presenter must grant permission to the Participant from the Participant 
Panel. To begin recording a session, click the "Record Session" button on the gray toolbar across the top 
of the eBLVD Client (the window displaying the Host PC's desktop). An .avi file will be created containing 
video only, but audio may be edited in later. View our Session Recording Guide. 

  

I need help setting up my Co-branding 

All pages of eBLVD can display your logo, colors and contact info on both the Presenter and Participant 
side. To configure your cobrand settings, click the "Configure Cobranding Preferences" link on the 
"Configure Preferences" page of your Online Meetings Center.  
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Tips for success 
Prior to starting your meeting:  

• Turn off any instant-messaging applications, notification software or other programs that may 
interrupt or distract from the meeting.  

• Set the desktop display to a neutral background and adjust display settings to a mid-range 
resolution (i.e., 1024x768) to improve the display for participants with lesser settings. This is also 
the optimal setting for recording a meeting.  

• Clean up your desktop before a meeting. Eliminate wallpaper and icons that may distract your 
participants.   

• Have the documents you wish to share ready to be accessed.  

• Run a trial meeting with an associate to anticipate questions and to familiarize yourself with the 
format of your online presentation. 

Managing your meeting: 

• Arrive a few minutes early to greet your participants as they arrive and start the meeting on time. 
It also helps to have a welcome presentation announcing the meeting and teleconference details. 

• Create a welcome screen and save it via the Presentation Controls Panel of your Meeting Manager 
to greet your attendees as they arrive at the meeting. 

• Encourage participation by using open questions such as “How does this apply...?” or “What do you 
think about...?”. 

• End the meeting clearly. Make sure all the participants know that the meeting is formally over and 
stay on the line to address any last questions. 

Managing the Conference Call: 

• Call in to the meeting from a location where there is little background noise. 

• Consider globally muting participants at the start of the meeting to avoid noise issues. Turn off 
system prompts and sounds for when attendees join or leave a meeting. Read the Voice 
Conferencing section of the help files to familiarize yourself with the conference call features. 

• Avoid using cellular and cordless phones because of static and use the phone handset or a headset 
instead of speakerphones because of background noise, tunnel effect and sentence clipping. 

• Turn off your call waiting. The beep of a new call on another line is heard by everyone on the 
teleconference. 

• Avoid putting your phone on hold during a teleconference. Your hold music will play into the 
conference call, and make it impossible for the other attendees to continue the meeting. 

• If you find you are having a sound quality issue, hang up and dial back in. Sometimes these 
problems clear themselves up when the bad connection is terminated. 
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Tutorials 
Try our online step-by-step tutorials. 
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About eBLVD 

Company Information 
Founded in 2001 and located in Southern California, eBLVD is a pioneer of web based communication 
software and professional remote access tools. 

  

Contact Information 
Phone: 

+1 760-727-7277 

+1 877-GET-eBLVD (877-438-3258) 

Fax: 

+1 760-454-0487 

Email: 

support@eBLVD.com 

  

Physical Address: 

2121 Palomar Airport RD #220 

Carlsbad , CA 92011 

  

Mailing Address: 

PO Box 130339 

Carlsbad , CA 92013 

mailto:support@eBLVD.com

